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Abstract

This application describes how to use the D-Series and C-Series laser sensor in a positioning application in
conjunction with a SEW servo drive. The necessary configuration of the D-Series and C-Series laser sensor and the
SEW inverter are described in this document. Further the wiring is also documented.
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DIMETIX

1 Introduction LASER DISTANCE SENSORS

1 Introduction

The laser distance sensor measures absolute distances. It is suitable for positioning applications to measure the
actual feedback position. Figure 1 shows a general setup for such an application.
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In this application note a SEW Eurodrive inverter is used to control the motor. The position is measured by a D-Series
or C-Series sensor of Dimetix. The setup of the sensor, the cable connection and the configuration of two product
series (MOVIDRIVE® B, MOVIAXIS®) are described.

O

Fig. 1: Positioning application

1.1 SEW-System requirements

Hardware: MOVIDRIVE® B with encoder card DEU 21B
or
MOVIAXIS® with encoder card XGS

Firmware versions: MOVIDRIVE® B: >= 18220916.15
MOVIAXIS® >= .28
DEU21B: >= 1
XGS >= 12
MOVITOOLS® MOTION STUDIO >= 5.80 SP2 (Service-Pack?2)

I
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DIMETIX

2 Configuration LASER DISTANCE SENSORS

2 Configuration

This chapter is a step by step configuration example. Just do each single step described later in this to configure the
sensor for the positioning application. For the C-Series sensor please change to chapter 2.2.

2.1 Setup of the D-Series sensor
2.1.1 Reset of D-Series sensor

Before proceeding, it is recommended to reset the sensor to its factory defaults. But keep in mind that all previously
done settings will be lost when performing a factory reset.

Steps

Description

1

Switch off the power supply used for the device

Press the reset push button and keep it pressed

Switch on the power supply used for the device

A WN

Keep the reset push button pressed until all status LED's (POWER, ERROR, DO1, DO2) flash for a short
time (about 0.5 seconds)

Release the reset push button

Switch off the power supply and wait 5 seconds

Switch on the power supply and wait until the green status LED (POWER) is on

0| N O U

Reset procedure executed successfully

NP

Fig. 2: Reset push button

S
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2 Configuration LASER DISTANCE SENSORS

2.1.2 Connection of Laser Sensor Utility with D-Series sensor

Steps Description
1 Connect the laser sensor over USB or RS-232 to the PC, start the Laser Sensor Utility software and
check the connection. Download and install the latest “Laser Sensor Utility” software
(www.dimetix.com/UtilitySW).
2 Download the special interface board firmware for the SEW-System:
a) Menu Tools => Firmware download => Download interface board firmware file
b) Select the following firmware file:
“DSERIES_IF_FW_V99_11_PAR_V2_SSI_RevisedStartSequence.dls”
¢) Wait until download is finished and sensor is reconnected
d) Close the download window
3 Download the configuration file “Dserie_10_SEW_24012023.cfg" with the “Laser Sensor Utility”.
Therefore click on Menu File => Download configuration file to device.
4 Select the configuration file: “Dserie_10_SEW_24012023.cfg”
5 Test the sensor with the SEW-System. If the measurements are not accurate enough for your control
unit, a special filter can be activated: see steps 6-8.
6 Connect the sensor again with the laser sensor utility.
optional |If needed, set the special moving target filter length. Therefore click on Menu Tools => Manual
command input
(; Laser Sensor Utility
¢ rredouion e
Manual command input ’@eria\
7 Activate the special filter with the command:
optional Send: sOc
Answer: g0?
Send: sOafi+2+100
Description: 100 is the filter length, min. value: 1 and max. value: 400
Answer: gOafi+2?
Send: sOA+0
Manual comman dinput [«]
e [ ew ]
Laser off
Temp
Single measurement
Tracking measursment
1
I
|
1
]
Clear COM trace Clear command history
8 Close manual command window and try again.
optional | If needed, adjust the filter length sOafi+2+xxx with an other value (see steps 6-8)
NZ
IS
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2 Configuration

2.1.3 Cable connection D-Series

The D-Series sensor must be connected to the DEU21B/XGS of the MOVIDRIVE® B or the MOVIAXIS®. Connect the
D-Series sensor with the internal screw terminal.

2.1.4 Connection of D-Series

DIMET

IX

LASER DISTANCE SENSORS

DEU21B / XGS D-Series
X14 / X64 Sensor
/ internal
‘ screw terminal
Data- 12 / T o T-
Data+ 4 | /f ’\\ o T+
Clock - 11 = ( ‘ o R-(Clock-)
Clock + 3 \ J o R+ (Clock+)
UB 15 = = \ ; o +24V
\‘ |
Gnd 8 | / o Gnd

Fig. 3: Connection from D-Sub to screw terminal

2.1.5 Error handling D-Series

In the configuration for the D-Series Sensor the error behavior “Latest valid measurement value” is selected. In an
error case (e.g. distance out or range E234) the last valid measurement is frozen until the sensor can measure again

(without an error).

File Tools Info

Connection

Measurement
characteristice.

Filter

Analog output

Digital output

ssl

User output
protocol

Device ID

Additional
Features

2 Laser Sensor Utility

Connected with: D-Series

Stand-alone
Mode

Controlled
Mode

Configuration

4-poleserial port usage SNSS|

" RS422
@ ssl

Ermor behavior sNSSle (distance output while emor)
" Replacement value
@ Latest valid measurement value

" Emor code

™ Attach error bit
Data coding
 binary  gray
Measurement data value

@ 24 bit  23bit

[¥ Attach error code

e

(0..16777215)

DOWNLOAD TO DEVICE |

- X
V242
),
COM trace DIMET(X
< govmtl
-> sove
<= gOve+000

<= gOv+00000000+00100000
-> stot

<= goot+a

- sladotl

<= g0ado+1+000+000+00001000
-> snadot2

<~ g0ad0+2+000+000+00001000
-> s01

<= g01+00000000+00000000
-> s02

<= g02+00000000+00000000
-> sODI1

<~ goDII+00000000

<~ gOfL400+00400

-> souot
<= gOuo£+00000000

-> sluga

<~ gOuga+00000010+00000010
-> suo

<= gOuo+00000000

-> s0SST

<~ gOssI:009

-> 3055Te

<~ g0S5Te-00000001

-> s0afitl

<= goafis

Status: |OK.

RESET

Clear trace

Fig. 4: Latest valid measurement value is selected
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2 Configuration

2.2 Setup of the FLS-C
2.2.1 Preparation FLS-C

D

DIMET(X

LASER DISTANCE SENSORS

1. The following items are needed to do the configuration of the FLS-C.

. RS-232 Configuration cable FLS / DLS (Part no. 500200)

. 24V DC Power supply

2. Download the UtilitySW from the website www.dimetix.com/Ink/sew and install it on a PC.

3. Download the configuration file and safe it on the PC.
To setup the FLS-C sensor, connect the sensor to a serial interface of a PC and power the sensor with 24VDC. Start

the UtilitySW and follow the steps below.

Check the connection to the sensor

&2 DLS / FLS Utility Unconnected [E=R R
File Tools Info
o Controlled Stand-alone 2 £ b,
Connection Mode Mode Configuration COM trace DIMET X
Software version and serial number
Serial number sNsn 277
Interface software version sNsv ???.
Module software version sNsv 77 Unconnected
Device ID. 0 i
Communication paramet
Port: COM1 -
Settings: |?: 19200 Baud, 7 Data bits, Parity Even j
cHECHFONNECTION | |
Status: | CONNECTION NOT CHECKED . RESET | Clear trace |
The UtilitySW shows information about the sensor
w2 DLS / FLS Utility Connected with: FLS-C [E=REE
File Tools Info
2 Controlled Stand-alone Z £ b,
Connection Mode = Configuration COM trace DIMET1X
Open COM1 @ 19200-7-even-1
Software version and serial number ->
= -> dg
Serial number sNsn 11110326 <- gOdg+083+47
i > alav
Interface software version sNsv 522 <- g03v+00410522
. -> s0sn
Meodule software version sNsv 41 FLS-C <- g0an+11110326
-> s0uc
2 <- gOuc+00000000+00000000
Device ID: 0 - —> sOuc+2+0
=-> s0uc+0+0
Communication parameters <- gluc+00000000+00000000
Port: CoM1 -
Settings: |7: 19200 Baud, 7 Data bits, Parity Even j
| Read configuration from device |
DISCONNECT |
Status: |OK RESET Clear trace

NP

S

D-Series / C-Series

Positioning with Dimetix distance sensor and SEW inverter

Page 7/16


http://www.dimetix.com/lnk/sew

2 Configuration

DIMETIX

LASER DISTANCE SENSORS

Select File/Download configuration file to device

w? DLS / FLS Utility

Connected with: FLS-C

- \

File | Tools Info

Load configuration...

Save configuration as... | ] Caonfiguration COM trace DIMET:X
Set default configuration Open COM1 @ 19200-7-even-1
Load cenfiguration from device... =
Download configuration file to device. 1 e
: 11110326 <~ gOdg+083+47
Exit E -> alav
I Interface software version sNsv 522 <- glav+00410522
E -> 30sn
Module software version sNsv 41 FLS-C <- g0sn+11110326
-» aluc
<- gluc+00000000+00000000
Device ID: 10 '] -> aluc+2+0
-» 30uc+0+0
~Communication parameters - <- gOuc+00000000+00000000
Port: COM1 -
Settings: |7:19200 Baud. 7 Data bits. Parity Even v
1 I Read configuration from device
DISCONNECT |
Status: |OK RESET J Clear trace

Select the file FLS_C_10_SEW_25072012.cfg.
This is the file you downloaded in 2.2.1 Preparation FLS-C on page 7

e

j Open

@@v| | v Computer » Local Disk (C:) » Users » admin » My Documents »

Organize = MNew folder

: MName
4.7 Favorites

B Desktop
& Downloads

=l Recent Places
44 Libraries
> 3 Documents
> Gf‘. Music
I || Pictures
- B Videos

I M Com puter

> G‘! MNetwork

File name:

| ] FLS_C_10_SEW_25072012.

Date modified Type

7/26/2012 8:56 AM

CFG-Datei

B
- | 3 | | Search My el |
0 @
Size
1KB
- [Configuration files (*.cfg) v]
[ Open 1v] [ Cancel ]

71N
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2 Configuration

DIMETIX

LASER DISTANCE SENSORS

An OK in the status line of the UtilitySW indicates a successful transfer of the configuration.
The FLS-C 10 is now ready to be connected to the SEW inverter.

@2 DLS / FLS Utility

Connected with: FLS-C

& = o] |

File Tools Info

Controlled
Mode

Stand-alone

Connection Mode

Configuration

Software version and serial number
Seral number sNsn 11110326.

Interface software version sNsv 522

Module software version sNsv | 41

D

Device |D:

[~ Communication parameters -

Port: comi -

b,
COM trace DIMETX

—> s0v+00000000+00100000
<— g0v?

—-» 301+00000000+00000000
<— g01?

—> 302+00000000+00000000
«<- g022

—» 30DI1+00000000

<— gODI12

—> s0uc+2+0

<- gluc+00000002+00000000
—» 30£i+0+0+0

<— g0fi?

-> s0uof+0

<- gluof?

->» aluga+l+l

FLS-C

Settings:

DISCONNECT \

|? 19200 Baud. 7 Data bits. Parity Even

j «<- gluga?

—> 30uo+0
<— gluo?
= a085Tet=—1

Read configuration from device | <- g035Ie?

—> 3055I+9

<- g05512

-> 3803

«— gls?
s0A+00000000
<- gOA?

o

Status:  OK

RESET Clear trace

2.2.2 Cable connection FLS-C

The FLS-C sensor must be connected to the DEU21B/XGS of the MOVIDRIVE® B or the MOVIAXIS®. Following
different possibilities are documented. Connect the FLS-C sensor with a 15 pin D-sub connector or an internal screw

terminal.

Connection of FLS-C (without heating)

DEU21B / XGS Dimetix FLS-C10

X14 / X64 D-Sub 15-pol.
Data- 12 — " \\ - | 37-
Data+ 4 |- 1/ | | 4T+
Clock- 11 |-= | ‘ | 5 R{(Clock-)
Clock + 3 = \ \ — 6 R+ (Clock+
W 15 |- ’J —{ 7 +24v
1\ / | 8 +24V
Gnd 8 [ e ~—| 14Gnd
— | —{ 15Gnd

Fig 1: Connection from D-Sub to D-Sub

N2
TIN
D-Series / C-Series

Positioning with Dimetix distance sensor and SEW inverter

DEU21B / XGS Dimetix
X14 / X64 FLS-C10
] internal
/ screw terminal
Data- 12 : . o T-
Data+ 4 / \ o T+
Clock - 11 | \ o Re(Clock-)
Clock + 3 J 5 o R+ (Clock+)
UB 15 k | o +24V
\
Gnd 8 ! ! o Gnd

Fig 2: Connection from D-Sub to screw
terminal
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2 Configuration LASER DISTANCE SENSORS

Connection of the FLS-CH (with heating)
If using a FLS-CH device with integrated heater, an external power supply must be used. Please do the wiring as
shown in the following diagram.

The FLS-CH includes a heater and therefore the current consumption is up to 2.5A. As a result, the
supply of power from the DEU21B/XGS is not possible.

DEU21B / XGS Dimetix
DEU21B / XGS Dimetix FLS-CH X14 / X64 FLS-C10
X14  / X64 Sub-D 15-pol. ™ internal

screw terminal
a1 /\ ot Data- 12 | /\ o T-
Data» 4 [~ { \ ] 4 Ti Data+ 4 | = / \ o T+
ata + - - | +
ok 11 L | | 5 re (o) Clock- 11 |2 ‘\ /‘ o R-(Clock-)
Clock + 3 \ / 6 R+ (Clock Clock + 3 5 — - o R+ (Clock+)
ock+ 3 T — 6 R+ (Clock+ 2%2%025TP \J
Va o V+
Gndeg. o Gnd ?\BA“D% 10.90 o Gnd
VDX X10.T0 T e 075 MXA’ X10.11 max. 0,752
R EgA\Z/ ngt Gnd ext D E%A\Z/EX Gnd ext
Fig 3: Connection from D-Sub to D-Sub Fig 4: Connection from D-Sub to screw
terminal

Install a proper ground connection between the ground of the FLS-C and the
MOVIDRIVE® B / MOVIAXIS®.

2.2.3 Error Handling FLS-C

In the configuration for the FLS-C “With error freezing” is selected. Therefore an error (e.g. a position jump) will be
detected. The sensor will be in the error state for about 5s before it automatically does a reset.

r ~
w2 DLS / FLS Utility Connected with: FLS-C [E=R
Eile Tools Info
} B e e .
Connection \ Mode Mode ECunflgurﬂtmng COM trace DIMETiX
= allve
Measurement Measurement characteristics sNuc - <— gOve+000
characteristics ¢ Standard 3 30v
~Mode <~ gOv+00000000+00100000
= -> 801
O
Akt < gO1+00000000+00000000
iE -> 802
<- g02+00000000+00000000
Analog output ~ —» 30DIL
<- g0DI1+00000000
st & -> sluc
Digital output | <~ gOuc+00000002+00000000
-> s0fi
" Timed (effect in user measurements only) <~ gOEL+00+00+00
== & Moving target RN,
e R <- gOuof+00000000
u put -> sluga
SEr oul
S @ With error freezing <- gOuga+00000001+00000001
-> sluc
. <- gluo+00000000
User offset/ " Without eror freezing P e
a<ih <- gOSSI+003
-> 5055Ie
DOWNLOAD TODEVICE <- g0S5Te-00000001
-> sluc
<- gOuc+00000002+00000000
Status: |OK RESET Clear trace
L

e
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2 Configuration LASER DISTANCE SENSORS

2.3 Error Handling MOVITOOLS® MOTION STUDIO

The MOVIDRIVE® B-inverter registers errors of the FLS-C Distance Sensor. Examine them in the Fault History of the
inverter.

To display the error with the MOVITOOLS® MOTION STUDIO, change the settings of the MOVITOOLS® MOTION
STUDIO to ‘Internal mode’.

Activate this mode under Settings / Authorization level: Password = ****1 -> OK.

[ MOVITOOLS®-MotionStudio - [Default_2]*
Project  Edit Network View FPlugin  Settings  Window  Help

OE-H & oD B HE X | [# Sean 11 Bl
Praject | Netzwerk i 1
e Defauk_2
....... ﬂ| Default
=3 Authonzation level @
Current: 100: INTERMAL
Password: =1
MOVITOOLS®-MotionStudic OK

The encoder diagnostics via MOVITOOLS® MOTION STUDIO or PLC is only available with MOVIDRIVE®
B. MOVIAXIS® does not support this function.

" To get the code, you may ask Dimetix (sales@dimetix.com).

The field 080 Developer code shows the error code. Add 200q to the displayed value to get the error code
corresponding to the FLS-C Distance Sensor reference Manual.

In this example, the fault memory 0 (last fault) is shown in the picture.

E MOVIDRIVE®E parametersi\Display values\Fault memory 0-4\Fault memory 0

080 Fault t-0 Description

Fault code 122 Fault "Absolute encoder option” / 55 encoder X14: Encoder signals
programmable emor

Suberror code 16644

080 Developer code 130

The field 080 Developer code is 130. Add 200 to it to get error 330, which corresponds to the Dimetix Error 330
Distance jump.

2.4 Error Handling PLC

Read out the error code with the parameter service of the PLC:
— Read the index 8883.0 of the MOVIDRIVE® B for remote diagnosis.
Add 2004 to get the error code corresponding to the Dimetix error list.

e
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3 MOVIDRIVE® B Setup for D-Series and C-Series
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LASER DISTANCE SENSORS

3 MOVIDRIVE® B Setup for D-Series and C-

GUI: encoder start-up
Select distance measurement device

Series

EY | motor encoder (x15)
.
=]

AV1HEZ}®

ﬁ Edit manually
@ Detect automatically
' Select

#= position detection ON

7 -

Distance encoder (xX14)

A51H®®

ﬁ Edit manually
@ Detect automatically
& Select

#= position detection ON

Select 'FLS-C 10 Dimetix" as your encoder
Distance encoder _“ t

D Encoder selection

1. Select the relevant encoder grouping

ﬁ Mounting

lJ SEW encoder ] @’ lgd Approved encoder l p""} [J Non-SEW encoder l :j
2. Select the encoder from the SEW database
™ FLS-C 10
Name Manufacturer Elecirical type Mechanical type Resolution &
EQI1329 Heidenhain EnDat2.1 Rotatory 32Incr.
EQMN1125 Heidenhain EnDat2.1 Rotatory S512Incr.
EQMN1325 Heidenhain EnDat2.1 Rotatory 2048Incr.
EQMN425 Heidenhain EnDat2.1 Rotatory S12Incr.
FLS-C 10 Dimetix SSI Linear 100pm (10,0 I/mm)
GM 401 o 551 Rotatory 4096Incr. |
HMG161 524 H2048 Hibner 551 Rotatory 4096Incr. =
Kueb 908 1xxxx2003 Kuebler SSI Rotatory 4096Incr.
Kueb 908102004 Kuebler SSI Rotatory 8192Incr.
LA41K TR Electronic SSI Linear 10pm (100,0 I/mm)
LC183 Heidenhain EnDat2.1 Linear 20pm (50,0 I/mm)
LE100 0,1mm TR Electronic SSI Linear 100pm (10,0 I/mm)
LE100 1mm TR Electronic SSI Linear 1000pm (1,0 I/mm)
LE200 0,1mm TR Electronic SSI Linear 100pm (10,0 I/mm)
LEZ00 CAN 0,1mm TR Electronic CANopen Linear 100pm (10,0 I/mm)
LE200 CAN 1mm TR Electronic CANopen Linear 1000pm (1,0 I/mm)

N cancsl

[

Qo
I
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3 MOVIDRIVE® B Setup for D-Series and C-Series
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Select the 'Mounting' tab, enter the traveling distance per motor revolution in um (adjustment to the mechanic)
! !

N

Distance encoder

[ :} Encoder selection ﬁ Mounting

Encoder mounting

ofthe

c ting direch
=
[Tjry in sense of rotation of motor

|

Travel distance on encoder per motor revolution
409600 pm

Start-up the motor-encoder

Switch on the position detection
Encoder settings
Motor encoder (X15)
AVIHX

|
ﬁ Edit manually

i

™ B [F4
U — S

¥z position detection ON

Distance encoder (X14)
-

FLS € 10°

p Edit manually
e 2 =
=

X Deselect
#= Position detection ON

e
71N
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[ Operation without motor encoder ]

@ Measure gear ratio ]

3 Position detection

Positioning with Dimetix distance sensor and SEW inverter

Page 13/16



4 MOVIAXIS® Setup for D-Series and C-Series
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4 MOVIAXIS® Setup for D-Series and C-Series

In GUI: drag XGS Card on slot 3 and drop it to distance encoder 1

Hardware configuration

Encoder
pool

Motor encoder

1. Parameter set

AV1H
Bew [
m D

Option cards

l } '

Distance encoder 1

Encoder card
Slot 3

Distance encoder 2

2. Parameter set

3. Parameter set

CICWEWCWEVCWCNEWCIC WV WEWEWEC)

Edit the encoder

‘Hardware configuration

Encoder
pool

Motor encoder
1. Parameter set

AV1H

Bea [
fmbinl ,

Paosition
detection

Option cards

Distance encoder 1

AK1H
B [

Encudercard

Slot 3

Distance encoder 2

2. Parameter set

3. Parameter set

RAAAAamaaaoaoaoane

e
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4 MOVIAXIS® Setup for D-Series and C-Series
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Select 'FLS-C 10 Dimetix' as your encoder

Distance encoder

D Encoder selection

ﬁ Mounting

1. Select the relevant encoder grouping

[J SEW encoder l @’ [Q Approved encoder l E} lJ Non-SEW encoder l T}
2. Select the encoder from the SEW database
™ FLS-C 10
Name Manufacturer Electrical type Mechanical type Resolution
EH1R EH1T ESxR ESxT ... |SEW TIL Rotatory 1024Incr.
EH1S E515 E525 EV1S ... |SEW SIN/COS Rotatory 1024Incr.
EQI1329 Heidenhain EnDat2.1 Rotatory 32Incr.
EQN1125 Heidenhain EnDat2.1 Rotatory 512Incr.
EQN1325 Heidenhain EnDat2.1 Rotatory 2048Incr.
EQN425 Heidenhain EnDat2.1 Rotatory 512Incr.
ES1H ES2H EV1H SEW Hiperface Rotatory 1024Incr.
FLS-C 10 Dimetix 551 Linear 100pm (10,0 I/mm)
GM 401 o 551 Rotatory 4096Incr.
HMG161 524 H2048 Hibner 551 Rotatory 4096Incr.
Kueb 9081xxxx2003 Kuebler SSI Rotatory 4096Incr.
Kueb 908 Lxxxx2004 Kuebler SSI Rotatory 8192Incr.
LA41K TR Electronic SSI Linear 10pm (100,0 I/mm}
LC183 Heidenhain EnDat2.1 Linear 20pm (50,0 I/mm)
LE100 0,1mm TR Electronic SSI Linear 100pm (10,0 I/mm)
LE100 imm TR Electronic SSI Linear 1000pm (1,0 I/mm)
R i Jp— P P e

m

ok | Cancel H

Select the 'Mounting' tab, enter the traveling distance per motor revolution in um (adjustment to the mechanic)

Distance encoder M
D Encoder selection ﬁ Mounting
Encoder mounting
C ting di of th i
Cm%% l in sense of rotation of motor
Ratio encoder / motor
:I'raveldlstanoeone ot B [ Operation without motor encoder ]
| 6553600 pm |
- - @ Measure gear ratio ]
N2
T
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4 MOVIAXIS® Setup for D-Series and C-Series
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Switch the position measurement system to external.
Hardware configuration

CICC W CIC WG

Encoder
pool

Option cards

Motor encoder Distance encoder 1

1. Parameter set

AV1H FLS-C 10
F T e ST Te—
i @l

Distance encoder 2

Encoder card
slot 3

2. Parameter set

3. Parameter set

Start-up the motor encoder.

e

TIN
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